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1 General
Access PE es un sistema de control de accesos diseñado para 
proveer los estándares más elevados de seguridad y flexibilidad 
en pequeñas y medianas instalaciones.
La estabilidad y capacidad de actualización del Access PE son 
fruto de su diseño en tres niveles: el nivel superior es el nivel de 
administración con servicios de control. Aquí se realizan todas 
las tareas administrativas, como por ejemplo el registro de 
nuevas tarjetas y la asignación de derechos de acceso.
El segundo nivel está formado por los controladores de acceso 
local (LAC) que se encargan de cada grupo de puertas o 
entradas. Incluso cuando el sistema no tiene conexión, un LAC 
puede tomar decisiones de control de accesos de forma 
independiente. Los LAC son los responsables del control de 
entradas, dirigen los horarios de apertura de puertas o solicitan 
códigos PIN en los puntos de acceso críticos.
El tercer nivel consiste en lectoras de tarjetas que, al igual que 
los Controladores, son idénticas en todos los controles de 
accesos BOSCH. Además de proporcionar un alto nivel de 
seguridad de forma constante, proveen una ruta de 
actualización y ampliación sencilla para el sistema, protegiendo 
así las inversiones anteriores.
La versión multiusuario del Access PE permite que distintas 
estaciones de trabajo controlen el sistema. Los niveles de 
derechos de usuarios personalizables regulan el acceso y 
garantizan la seguridad. De esta forma es posible, por ejemplo, 
mantener los datos de las tarjetas en una estación de trabajo 
mientras se utiliza otra para verificar si un empleado se 
encuentra en el edificio.
Access PE provee una configuración extremadamente flexible 
de los derechos de acceso, los modelos de tiempo y los 
parámetros de entrada. La siguiente lista ofrece una 
descripción general de las funciones más importantes:

Asignación de tarjetas de forma rápida y sencilla:



Access Professional Edition 2.1 General | es 5

Bosch Access Systems GmbH Guía del usuario   | V 2.1.0.1 | 2011.10

Se pueden asignar hasta tres tarjetas por persona de forma 
manual o utilizando una lectora con diálogos conectada a un PC 
mediante una conexión en serie. Sólo puede haber una tarjeta 
activa por persona en todo momento. Cuando se actualizan las 
tarjetas, la tarjeta más antigua se sobrescribe automáticamente 
y se invalida. De esta forma, se evita que tarjetas antiguas 
obtengan acceso incluso aunque las personas responsables se 
olviden o no puedan cancelarlas.

Derechos de Acceso (incluidos Privilegios de Grupo)
Cada persona puede heredar privilegios de grupo y tener 
derechos individuales asignados. Los privilegios pueden estar 
restringidos por zona y tiempo con una precisión de hasta un 
minuto. Los privilegios de grupo se pueden utilizar para limitar 
los derechos de acceso de un usuario de tarjeta o de todos los 
usuarios de forma simultánea. Los privilegios de grupo pueden 
depender de los modelos de tiempo que restringen su acceso a 
determinadas horas del día.

Seguimiento de acceso
Al definir Zonas es posible realizar el seguimiento e imponer 
una secuencia correcta de accesos. Incluso sin seguimiento, 
esta configuración permite mostrar la ubicación de un usuario 
de tarjeta.

Sistema anti-acceso reiterado
Cuando se lee una tarjeta, puede bloquearse durante un 
período de tiempo determinado para que no se pueda entrar al 
mismo punto de acceso. Gracias a esta función, se puede evitar 
el acceso reiterado en el que un usuario entrega su tarjeta a 
través de la barrera para facilitar el acceso a una persona no 
autorizada.

Cancelación Automática de las tarjetas cuando Caducan
A menudo, los visitantes y el personal temporal necesitan 
acceso únicamente durante un período limitado de tiempo.



6 es | General Access Professional Edition 2.1

  | V 2.1.0.1 | 2011.10 Guía del usuario Bosch Access Systems GmbH

Las tarjetas se pueden registrar para un período específico de 
tiempo, de forma que pierdan su validez automáticamente 
cuando dicho período termine.

Modelos de Tiempo y Modelos de Día
Es posible asignar a un usuario de tarjeta modelos de tiempo 
específicos que regulen las horas durante las que tiene acceso. 
Los modelos de tiempo se pueden definir de forma flexible 
utilizando modelos de día que determinan con exactitud los 
días de la semana, los fines de semana, los días festivos y los 
días especiales que difieren de los días laborables normales.

Identificación mediante código PIN
En lugar de una tarjeta, una persona puede utilizar un código 
PIN especial para obtener acceso.

Verificación mediante código PIN
Las zonas especialmente problemáticas se pueden programar 
para que requieran códigos PIN adicionales. A su vez, esta 
protección puede depender de los modelos de tiempo, de 
forma que, por ejemplo, sólo se requiera un código PIN para el 
acceso en días festivos o fuera del horario laboral establecido.

Administración de Puertas Flexible
La parametrización flexible de modelos de puertas 
independientes permite un equilibrio óptimo entre la seguridad 
y la comodidad. La"derivación" o período de supresión de 
alarma se puede especificar individualmente para regular el 
tiempo durante el cual la puerta permanece abierta. En 
cooperación con un sistema de alarma, el punto de acceso se 
puede bloquear de forma opcional.

Apertura de Puertas Periódica
Para facilitar el acceso, las alarmas de puertas se pueden 
derivar para que abran las puertas durante períodos de tiempo 
específicos. Los períodos de apertura de puertas se pueden 
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definir manualmente o automáticamente mediante un modelo 
de tiempo.

Hora y Asistencia
Los puntos de acceso se pueden parametrizar para registrar las 
entradas y salidas para controlar los horarios y la asistencia.

Diseño de tarjetas
El módulo gráfico adicional Card Personalization 
(Personalización de Tarjetas, CP) se integra completamente en 
el sistema de control de accesos y permite al operador crear 
tarjetas sin necesidad de cambiar de aplicación.

Asignación de Fotos
Aunque el módulo adicional Card Personalization 
(Personalización de Tarjetas, CP) no esté activado, la 
identificación fotográfica se puede importar y asociar a los 
usuarios de las tarjetas.

Offline locking system (Sistema de Bloqueo sin Conexión)
Las zonas que, por cualquier motivo, no están cubiertas por el 
sistema de control de accesos de alta disponibilidad en línea, 
pueden bloquearse de todos modos sin conexión.

Administración de los dispositivos de vídeo
Las entradas se pueden equipar adicionalmente con cámaras 
para identificar y realizar un seguimiento de los movimientos de 
las personas que las utilizan. 

1.1 Inicio de Sesión de Usuario
Inicie la aplicación Logviewer (Visor de Registros) por medio 

del icono del escritorio  o seleccionando Inicio > Archivos 
de programa > Access Professional Edition > Video Logviewer 
(Visor de Registros).
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Las aplicaciones del sistema están protegidas frente al uso no 
autorizado. Se requiere un inicio de sesión con un nombre de 
usuario (username) y una contraseña (password) válidos para 
acceder a los subsistemas basados en cuadros de diálogo.

La lista desplegable anterior se puede utilizar para seleccionar 
el idioma (Language) de interacción que se desee. El idioma 
predeterminado es el idioma que se utilizó al instalar la 
aplicación. Si se produce un cambio de usuario sin reiniciar la 
aplicación, se mantendrá el idioma anterior. Por ello, es posible 
que el cuadro de diálogo aparezca en un idioma no deseado. 
Para evitarlo, inicie sesión de nuevo en Access PE.
Las aplicaciones del Access PE se pueden ejecutar en los 
siguientes idiomas:
– Inglés
– Alemán
– Ruso
– Polaco
– Chino (RPC)
– Neerlandés
– Español
– Portugués (Brasil)
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Si se introduce una combinación correcta de nombre de 
usuario y contraseña, aparecerá el botón Change Password 
(Cambiar Contraseña). Este botón se puede utilizar para 
cambiar la contraseña en un nuevo cuadro de diálogo.

El botón Start the application (Iniciar la aplicación) sirve para 
comprobar los privilegios de usuario e iniciar la aplicación 
según estos. Si el sistema no puede autenticar el inicio de 
sesión, aparecerá el siguiente mensaje de error: Wrong 
username or password! (Nombre de usuario o contraseña 
incorrectos)

Inicio de sesión mediante Personnel Management 
(Administración de Personal)
Si el usuario ya ha iniciado sesión en la aplicación Personnel 
Management (Administración de Personal) del Access PE y sus 
derechos incluyen LogViewer (Visor de Registros), es posible 

invocar directamente el visor utilizando el botón  de la lista 
de herramientas, sin necesidad de iniciar sesión de forma 
independiente en la aplicación LogViewer (Visor de Registros).

¡NOTA! 
Todos los elementos como nombres de dispositivo, etiquetas, 
modelos y programas de derechos de usuario se muestran en el 
idioma en el que se introdujeron. Igualmente, los botones y 
etiquetas controlados por el sistema operativo aparecen en el 
idioma del sistema operativo.
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1.2 Diseño del cuadro de diálogo principal

1 = Barra de menús: Contiene todas las funciones de 
diálogos organizadas en menús.

2 = Barra de herramientas: Contiene las funciones más 
importantes de los diálogos como botones de iconos.

3 = Barra de título: Cumple con los estándares de 
Windows e incluye botones para minimizar y cerrar la 
ventana de diálogo principal.  El nombre del usuario 
actual se muestra entre corchetes.

4 = Estado de los dispositivos: Enumera las entradas y 
los dispositivos configurados junto con su estado de 
conexión.

5 = Lista de mensajes: Lista de los mensajes recibidos 
hasta el momento. La visualización se puede 
modificar con ajustes de filtros específicos.

6 = Selección de filtros: Filtros predefinidos y 
personalizados que se pueden seleccionar en el 
cuadro combinado.
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1.3 Barras de Menús y de Herramientas
Las siguientes funciones están disponibles para la evaluación 
de los registros mediante menús y botones de icono.

7 = Activación de alarmas: Activa/desactiva las alarmas 
de los mensajes.  Un mensaje entrante puede ir 
acompañado de una señal acústica.

8 = Barra de estado: Fechas de los archivos de registro 
abiertos. Estado del servicio LAC. Ajustes de alarma.

Menú Función Botón de 
icono

Descripción

File 
(Archivo)

Print... 
(Imprimir...
)

 

Se imprimen los 
mensajes de registro 
visualizados

Exit (Salir) Se cierra la aplicación 
Logviewer (Visor de 
Registros).
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Filter 
(Filtro)

Filter 
definition 
(Definición 
de filtro)

                   

Se abre el cuadro de 
diálogo de filtrado de 
mensajes.

Continuous 
mode on 
(Modo 
continuo 
activado)

                   

Se inicia la 
visualización de 
mensajes continua.  
Este icono sólo está 
activo cuando la 
función ya no se está 
ejecutando y se ha 
establecido el filtro de 
mensajes en la fecha 
actual.
La visualización de 
mensajes continua es 
el ajuste 
predeterminado.

Continuous 
mode off 
(Modo 
continuo 
desactivad
o)

                   

Se detiene la 
visualización de 
mensajes continua.  
Este icono sólo está 
activo cuando la 
visualización de 
mensajes continua se 
está ejecutando.

Events 
previous 
day 
(Eventos 
del día 
anterior)

  

Pasa a los mensajes 
del día anterior.

Events next 
day 
(Eventos 
del día 
siguiente)

  

Se cambia a los 
mensajes del día 
siguiente.

Menú Función Botón de 
icono

Descripción
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View (Ver) Barra de 
símbolos

Oculta/Muestra la 
barra de 
herramientas.
Activada de forma 
predeterminada.

Barra de 
estado

Oculta/Muestra la 
barra de estado.
Activada de forma 
predeterminada.

sin elemento de menú

? (Ayuda) Help topics 
(Temas de 
ayuda)

                     

                  

Abre este archivo de 
ayuda.

About 
Logviewer 
(Acerca del 
Visor de 
Registros)

Se abre la ayuda de 
Logviewer (Visor de 
Registros) del Access 
PE.

Menú Función Botón de 
icono

Descripción



14 es | Diario de registros Access Professional Edition 2.1

  | V 2.1.0.1 | 2011.10 Guía del usuario Bosch Access Systems GmbH

2 Diario de registros
Todos los procesos llevados a cabo en el sistema de control de 
accesos de Access PE (incluidos, por ejemplo, los datos para el 
inicio y cierre de sesión de los usuarios en una estación de 
trabajo) se transmiten y almacenan por medio de mensajes al 
respecto en los registros de eventos. Si los clasifica, puede 
separar los mensajes relacionados con la seguridad (mensajes 
de alarma) de los mensajes meramente informativos; de esta 
manera, le resultará más fácil implementar cualquier medida 
adicional que sea necesaria.
Si desea obtener una presentación clara con la opción de filtrar 
los mensajes importantes y alertar a los usuarios de los cuadros 
de diálogo, puede instalar e iniciar el cuadro de diálogo 
Logviewer (Visor de registros) en cualquier estación de trabajo, 
siempre que los derechos de usuario de la persona que inicie 
sesión lo permita.

2.1 Lista de mensajes
La principal función de Logviewer (Visor de registros) consiste 
en mostrar los mensajes de registro, tanto los actuales como 
los históricos.

De forma predeterminada, la visualización se actualiza 
continuamente con los mensajes entrantes.  Los botones de 
icono correspondientes aparecen con los siguientes estados: 

.
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Al iniciar Logviewer (Visor de registros), aparecen los mensajes 

de la fecha actual.  El botón  sirve para mostrar los 
mensajes de los días anteriores.  Cada día se crea un archivo de 
registro con el formato de nombre de archivo 
Msg<aaaammdd>.log en el siguiente directorio: 
C:\BOSCH\Access Professional Edition\Data\MsgLog. Todos 
estos mensajes se pueden mostrar en Logviewer (Visor de 
registros).
Las columnas de la lista de mensajes incluyen la siguiente 
información:

Columna Descripción

(sin título) Representación simbólica de la 
categoría del mensaje como se define 
en Configurator (Configurador).

(sin título) Identificación de los mensajes para los 
que existe una grabación de vídeo: 

Date (Fecha) Fecha y hora de creación del mensaje.

LAC/PC Origen del mensaje: nombre del 
controlador o la estación de trabajo.

Reader/Login 
(Lectora/Inicio de 
sesión)

Origen del mensaje si el controlador 
sólo lo ha reenviado.  Si el origen es una 
estación de trabajo, se indica el nombre 
del usuario de la misma.

Location (Door) / 
Program (Ubicación 
[Puerta] / 
Programa)

Nombre de la entrada, señal u otra 
instalación. Si se trata de una estación 
de trabajo, se indica el nombre de la 
aplicación.

No. (Número) Número del mensaje según la lista de 
textos del registro de eventos de 
Configurator (Configurador).
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Puede personalizar la lista de mensajes como desee. Por 
ejemplo, se puede cambiar el orden de las columnas 
arrastrando y soltando sus encabezados.  De esta forma, puede 
dar relevancia a aquellas columnas que considere más 
importantes.
Para encontrar los mensajes que le interesan con una mayor 
eficacia, la lista le permite organizar (cambiando de orden 
ascendente a descendente) haciendo doble clic en el 
encabezado de cualquier columna.

Message (Mensaje) Texto del mensaje como se define en el 
Configurator (Configurador).

Card-No. (Número 
de Tarjeta)

Número de la tarjeta (siempre que el 
sistema pueda leerlo y reconocerlo).

Last name 
(Apellido)

Apellido del usuario de la tarjeta.

First name 
(Nombre)

Nombre del usuario de la tarjeta.

Company / Dept. 
(Empresa/
Departamento)

Empresa o departamento del usuario 
de la tarjeta.

Local date (Fecha 
local)

Si el AMC se encuentra en una zona 
horaria diferente, se mostrará aquí la 
hora de creación local del mensaje.

Columna Descripción

¡NOTA! 
En función de los derechos asignados al usuario, los mensajes 
visualizados estarán más o menos limitados. Para los usuarios a 
los que sólo se les permite ver sus propios mensajes, se filtran 
aquellos que pertenecen a otras personas. Para los usuarios a 
los que no se les permite ver los datos sobre el personal, las 
últimas cuatro columnas del contenido aparecen en blanco.
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2.2 Filtrado de mensajes
Para restringir la visualización de mensajes según criterios 
específicos, haga clic en Filter > Filter Definition (Filtro > 

Definición de Filtro) o en el botón de icono  de la barra de 
herramientas.  Se abrirá un cuadro de diálogo para seleccionar 
los criterios de filtro.

Puede filtrar los mensajes según los siguientes criterios:
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Criterios de 
filtro

Descripción Notes (Notas)

Time period from 
... to... (Período 
de tiempo de ... a 
...)

Es posible restringir 
la visualización a un 
determinado período 
de tiempo si 
introduce fechas 
aquí.  Se puede 
introducir la fecha 
actual como la fecha 
más reciente.
Al introducir otras 
fechas de eventos 
pasados, puede 
cambiar o ampliar los 
datos que ya han sido 
mostrados.

No resulta 
aconsejable 
especificar un 
período de tiempo 
muy largo para la 
visualización 
debido a que se 
leerán todos los 
archivos de 
registro. Se 
recomienda un 
máximo de un mes 
en total en función 
del tamaño de los 
archivos de 
registro.
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Name (Nombre) La visualización se 
puede limitar a las 
personas cuyos 
nombres coincidan 
con los criterios del 
filtro.

Los filtros Name 
(Nombre), 
Company/Dept. 
(Empresa/
Departamento) y 
card (tarjeta) sólo 
se pueden usar de 
forma individual, 
no se permite su 
combinación.

Company/Dept. 
(Empresa/
Departamento)

La visualización se 
puede limitar a 
personas de 
empresas o 
departamentos 
específicos.

card (tarjeta) La visualización se 
puede limitar a las 
personas cuyos 
números de tarjeta 
estén dentro de un 
rango determinado;  
por ejemplo, todos 
los números de 
tarjeta que 
comiencen por 6.

Entrances 
(Entradas)

Limita la visualización 
a los mensajes 
relacionados con 
entradas específicas.

Criterios de 
filtro

Descripción Notes (Notas)
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Guardando y cargando nuevamente los filtros
Para evitar tener que redefinir los filtros cada vez que reinicie el 
programa, el Logviewer (Visor de registros) le permite 
almacenar y cargar de nuevo los ajustes de filtro que desee.
Tras definir sus ajustes de filtro personales, puede 
almacenarlos haciendo clic en Save... (Guardar...) en la parte 
inferior del cuadro de diálogo.  De forma predeterminada, los 
ajustes de filtro con nombre (<nombre de archivo>.flt) se 
almacenan en C:\Archivos de programa\BOSCH\Access 
Professional Edition\Data\Cfg.

Mensajes 
(Mensajes)

Limita la visualización 
a determinados tipos 
de mensajes.

Alarm siren with 
.wav file (Sirena 
de alarma con 
archivo .wav)

Es posible reforzar 
los mensajes de 
alarma con la 
reproducción de una 
señal acústica.  Se 
puede seleccionar 
cualquier archivo de 
sonido del sistema 
para que acompañe a 
la alarma.

Criterios de 
filtro

Descripción Notes (Notas)

¡NOTA! 
Un filtro sólo está activo mientras se ejecuta la aplicación.  
Cuando LogViewer (Visor de Registros) se reinicia, se 
restablecen los ajustes predeterminados (por ejemplo, el día 
actual o la desactivación de filtros).
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Los ajustes de filtro guardados se pueden volver a cargar y 
activar seleccionándolos en el cuadro combinado Filter (Filtro) 
de la esquina inferior izquierda.
Para consultar o editar un filtro definido anteriormente, 

primero cárguelo y ábralo haciendo clic en  y, a 
continuación en Load... (Cargar...) en el cuadro de diálogo 
Filter view (Vista de filtro).

Los ajustes de filtro cargados se pueden verificar, modificar y 
finalmente aplicar haciendo clic en OK (Aceptar).

2.3 Activación del modo de alarma
Al hacer clic en Activate alarm (Activar alarma) o seleccionar 
un filtro guardado con activación de alarma, la ventana de 
LogViewer (Visor de Registros) se cierra y pasa a modo en 
espera,  mostrándose en la bandeja del sistema con el icono 

.  Al pasar el ratón sobre el icono, aparecerá el siguiente 
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texto: Access PE: Wait for alarm (Access PE: Espere la alarma).  
Si hace doble clic en el icono, la ventana de diálogo puede 
pasar a primer plano en cualquier momento.

Si se recibe un mensaje, la ventana principal vuelve a primer 
plano.
Cuando la casilla Sound Off (Sonido Desactivado) no está 
activada, la alarma entrante incluye una señal acústica.

¡NOTA! 
Cuando Alarm mode (Modo de alarma) está activo, no se puede 
cerrar la aplicación con el botón x de la barra de título ni con 
las opciones File > Exit (Archivo > Salir).  En su lugar, 
LogViewer (Visor de Registros) vuelve al modo en espera.
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3 Personnel Management 
(Administración de Personal)

3.1 Estado de los dispositivos
La visualización del estado de los dispositivos aparece junto a 
la lista de mensajes de registro.

Los siguientes símbolos indican el estado de los dispositivos:

El controlador está conectado.

El controlador no está conectado.

No se puede determinar la conexión con el 
controlador.

La tarjeta de ampliación está conectada.

La tarjeta de ampliación no está conectada.

La conexión con la tarjeta de ampliación no se 
puede determinar.

Conexión con la entrada: Correcta.

La conexión con la entrada presenta fallos.
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Controles
Esta función sólo está activa cuando el usuario que ha iniciado 
sesión tiene derechos de control de puertas.
Las entradas seleccionadas en la lista de estado de los 
dispositivos con las que existe conexión pueden recibir órdenes 
mediante el menú contextual (clic con el botón derecho) o el 
menú Door management (Administración de puertas). 

               
El nombre de la entrada seleccionada se lee en el contexto.

No se puede determinar la conexión con la 
entrada.

La entrada está bloqueada.

La entrada está abierta / abierta durante mucho 
tiempo.

La entrada está abierta durante demasiado 
tiempo / posible intrusión.

Conexión con la lectora: Correcta.

La conexión con la lectora presenta fallos.

No se puede determinar la conexión con la 
lectora.

¡NOTA! 
La visualización del estado de las lectoras Wiegand puede ser 
errónea.  Como no pueden responder a solicitudes de estado, 
aparece en línea una lectora Wiegand parametrizada siempre 
que su controlador también esté en línea.
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Open (Abrir) <Entrada> La entrada selecciona se abre 
una vez (para una persona).

Long-term open (Abrir a 
largo plazo) <Entrada>

La entrada seleccionada se 
abre durante más tiempo.

Lock (Bloqueo) <Entrada> La entrada seleccionada está 
bloqueada.
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4 Reportes
Puede usar las funciones de lista del Access PE para recopilar 
los contenidos de la base de datos de una forma específica y 
organizarlos en un formato claro para su impresión.
Si desea filtrar los resultados de modo que sólo se muestren 
los datos que necesita conocer el usuario, puede utilizar los 
diseños predefinidos, que proporcionan información específica 
acerca de un cierto aspecto del control de accesos (por 
ejemplo, quién tiene las autorizaciones de un tipo determinado 
para cada puerta).

4.1 Reportes: Vista de página
Los archivos de registro abiertos se pueden guardar o imprimir. 
El elemento de menú File > Print (Archivo > Imprimir) o el 

botón  abren una previsualización.
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La vista de la página de reportes ofrece una serie de 
herramientas para modificar y manipular la visualización:

¡NOTA! 
Todos los archivos de registro abiertos se imprimirán.
Cierre todos los archivos que no desee imprimir o reduzca la 
selección a los mensajes más importantes.

Botón Significado Descripción

 
Exportar La lista se puede exportar a un 

archivo para un procesamiento 
adicional. Están disponibles los 
siguientes formatos:
Formato de Documento Portátil 
de Acrobat (PDF)
Valores Separados por Comas 
(CSV)

 
Print 
(Imprimir)

Imprime el reporte mediante un 
cuadro de diálogo de impresión 
que permite configurar una 
impresora predeterminada.

Selecciona
r página

Los botones de flechas llevan a la 
primera, la anterior, la siguiente o 
la última página del reporte.  Este 
control también permite mostrar 
el número actual y total de 
páginas del reporte.

No. of 
pages 
(Número 
de 
páginas)

Muestra la página actual y el 
número total de páginas.

 
Zoom La escala de visualización 

estándar (100%) puede cambiarse 
según sea necesario.
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Exportación de listas

Pulse el botón  para abrir un cuadro de diálogo para definir 
los criterios de exportación.

El campo de la lista de selección Format (Formato) ofrece los 
formatos de salida .pdf (para enviar y almacenar los resultados 
de búsquedas específicas) y .csv (para un procesamiento 
adicional de los datos).
Al exportar datos a un archivo .csv, éste se puede procesar en 
cierta medida sobre la marcha.

Además de indicar los valores de Delimiter (Delimitador) y 
Mode (Modo) para la exportación, también puede excluir o 
aislar de la misma las opciones de Report and Page sections 
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(Secciones de Reportes y Páginas), que son los encabezados 
de columna y los detalles de página, y Group sections 
(Secciones de grupo), que son los datos seleccionados.
Puede seleccionar una de las siguientes opciones para el 
campo Destination (Destino).
– Application (Aplicación): abre el archivo con la aplicación 

apropiada. Esta aplicación también debe estar instalada en 
el equipo. Los archivos .pdf se abren con Adobe Acrobat 
Reader, mientras que los archivos .csv se abren con MS 
Excel.

– Disk file (Archivo de disco) (opción predeterminada): abre 
un cuadro de diálogo del Explorador para seleccionar el 
directorio que desee. Se sugiere un nombre para guardar 
el archivo

– Exchange folder (Carpeta de Exchange): el archivo se 
puede enviar directamente a un destinatario de MS 
Outlook.

– Lotus Domino Mail: el archivo se puede enviar 
directamente a un destinatario de Lotus Mail.
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